
A Hot Zone Button.
The Button Wizard consists of two pages: Command and Size.

The Command Page:

This page is the same as the other two. Just specify the application to start and select "Hot Zone."

The Size Page:

"Height" and Width" refer to the size of the Hot Zone in pixels.    Once you have specified the height and width, click 
Finish. Nothing will appear on the Theme, but if you move your cursor around you will eventually find the Hot Zone. 
When you switch to Work Mode, clicking on the Hot Zone will start the application.



A Picture Button.
The Button Wizard consists of three pages: Command, Picture and Text.

The Command Page:

This page is used to select the application to be started by the button and the kind of button.
Start by identifying the application you want that button to start. You can either type in the path (for example, c:\
program files\microsoft office\office\excel.exe) or use the folder at the right to browse to that location. If you want 
the button to open a My Computer window to a drive or folder, key in "explorer [drive letter]\:[folder name]" without
the quotes and substituting the drive letter and folder name for the bracketed items; for example, explorer c:\
mydoc. There are also commands in the drop down list: about, quit, minimize, shutdown, moved, closeform, 
showdesktop, open, home, desktop, programs, documents, run, findfile and, if there are additional forms in the 
Theme, the commands “Go to Form X” and “Popup Form X” (where "X" stands for the form number). "moved" and 
"closeform" are covered below in the section Forms.
Next, select "Button."
Click "Next"

The Picture Page:

This page is used to assign pictures to the button. A button may have three different faces: the UP face (the Main 
Picture and what you see normally), the HIGHLIGHT face (the Second Picture and what you see when the cursor 
moves over the button, and the DOWN face (the Third Picture and what you see when the cursor is clicked on the 
button). By default, Talisman uses the application's icon for all three pictures. Pictures in the bmp, jpg and jpeg 
formats may also be used.
If you have other graphics that you want to use you can. Uncheck the "Use file icon" box and click on the folder to 
browse to your picture's location and select it.
If you want to delete a picture, click on the button marked "X."
If you selected Microsoft's Excel as the application on the Command Page of the Wizard, Excel's icon should appear 
in all three Picture windows.
You can move the application's icon to a new position on theme by dragging (see below Locations and Moving 
Buttons).

Load button list display all available BTN3 templates in theme folder and in ../talisman/buttons folder. BTN3 file is a 
BMP-file with three phases of button: normal, highlighted, pressed.

The Text Page:

This page is used to define a name for the button. The page has two parts. The part on the left shows the button 
picture and the name you may give it. On the right are the controls for setting up the name.
If Excel was the application selected, the executable will be spelled out in the Textstring box; for example, 
excel.exe. By default, Talisman uses the MS Sans Serif font, 8 point regular, light blue. If you want to change the 
name or delete the extension, make the change in the Textstring box. If you do not want to name the button, delete
the Textstring.
If you want to change the font, use the Change Font button, the button to the right of the font with the three dots in
it.. This brings up the standard Windows font dialog box. If you want to use other than the Talisman default font, 
change the font and size in the Windows font dialog box.
You can change the font's display color by clicking on the Text color button. This brings up the standard Windows 
color picker. For the use of the other color, see Color and Transparency.
You can move the textstring to a new position on your future button by dragging (see Locations and Moving 
Buttons).
The button will appear on the Theme. Switching to Work Mode will activate the button.



A Text String Button.
The Button Wizard consists of two pages: Command and Text.

The Command Page:

This page is used to select the application to be started by the button and the kind of button.
Start by identifying the application you want that button to start. You can either type in the path (for example, c:\
program files\microsoft office\office\excel.exe) or use the folder at the right to browse to that location. If you want 
the button to open a My Computer window to a drive or folder, key in "explorer [drive letter]\:[folder name]" without
the quotes and substituting the drive letter and folder name for the bracketed items; for example, explorer c:\
mydoc. There are also commands in the drop down list: About, Quit, Shutdown, Restart, Moved, Closeforms and, if 
there are additional forms in the Theme, Go to Form X (where "X" stands for the form number). "Moved" and 
"Closeforms" are covered below in the section Forms.
Next, select "Text String."
Click "Next"

The Text Page:

This page is used to define a name for the button. The page has two parts. The part on the left shows the button 
text string. On the right are the controls for setting up the name.
If Excel was the application selected, the executable will be spelled out in the Textstring box; for example, 
excel.exe. By default, Talisman uses the MS Sans Serif font, 8 point regular, light blue for the UP color and a 
HIGHLIGHT color of yellow. If you want to change the name or delete the extension, make the change in the 
Textstring box.
If you want to change the font, use the Change Font button. This brings up the standard Windows font dialog box. 
Change the font and size in the Windows font dialog box.
You can change the font's UP color by clicking on the Text color button and the HIGHLIGHT color by clicking on the 
Color button. Both buttons bring up the standard Windows color picker.
You can move the text label in a new position on your future button by dragging (see Locations and Moving 
Buttons).
Click Finish. Your Text Button will appear on the Theme. Switching to Work Mode will activate the button.
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Adding Buttons
Right click in an empty space in the Talisman Window and switch to the Edit Mode. A new menu appears. Select 
“New,” then "Button." When you select "Button," the Button Wizard appears. The Wizard consists of different pages 
depending on what type of button you select.

A Picture Button
A Text String Button
A Hot Zone Button
Locations and Moving Buttons



Adding Forms
Before adding forms, you should review the section Forms .



Adding Pictures and Picture from Files.
One of the really nice things about Talisman is that you can decorate your Theme with pictures - pictures of your 
family, vacation, of something special like a motorcycle, or of a work of art. The only limits to the number of 
pictures you can display are the sizes of the pictures and the amount of screen real estate you have.
The difference between "Pictures" and "Pictures from File" is in how Talisman handles the picture itself. "Pictures" 
are saved within Talisman and become an integral part of the Theme. "Pictures from Files" are saved within Talisman
as just a pointer to the picture's disk location.
When "Picture" or "Picture from File" is selected, Talisman opens the standard Windows Open dialog box. Browse to 
the picture's location and select it. After you click on "Open," the dialog box will close and picture will appear on the
Theme. Pictures may be in bmp, jpg or jpeg format.
Pictures are initially placed on the screen at the location where you right clicked. Pictures can be moved just like 
buttons.



Adding Shapes
Shape is a rectangle with any solid color without any command (like a picture button). It eliminates the 
need to create rectangular color blocks in an outside graphics editor and add them as pictures.



Adding Text Blocks.
Text Blocks are decorative objects. A Text Block is a block of text. Talisman will handle a block up to 64K in size. A 
Text Block can be used for things like reminder lists, quotations or excerpts from a book. Creating a Text Block is a 
three step process: creation, completion, and position.

Creating a Text Block.

In Edit Mode, right mouse click on the Theme to bring up the pop-up menu, then select New>Text block. When you 
release the mouse button, "New text block. Click here to edit." will appear on the Theme. Left clicking on those 
words will open the text block for editing and a scroll bar will appear at the right. When a text block is created, 
Talisman assigns a size for the display of the text block of 200 pixels wide by 100 pixels high. This size can be 
changed, but only in the Talisman Editor.

Completion of the Text Block.

Text can be keyed in directly to the text block. Text can also be copied and pasted using right mouse clicks or 
standard keyboard commands (Ctrl+c for copy and Ctrl+v for paste). When you are finished editing, click outside 
the Text Block. Text Blocks cannot be edited or scrolled in Work Mode

Position of the Text Block.

Text Blocks are initially placed on the screen at the location where you right clicked. They can be moved just like 
buttons and pictures.

Some Comments on Formatting Text.

The Text Block does not support tabs or word wrap. Indents or centering must be accomplished with spaces. The 
Enter Key must be pressed at the end of each line; if it is not, the text will continue to flow to the right until the 
Enter Key is pressed. 
Resizing of the Text Block is available only in Talisman Editor .



Adding new objects
Talisman has been designed so that almost all editing can be performed without ever using the Talisman Editor. 
Using the right mouse click in the Edit Mode, the main picture can be changed, the color of certain objects can be 
changed, and objects - buttons, pictures, shapes, text blocks, and forms - can be changed or added to the Theme.
As mentioned earlier, objects are either interactive or decorative. Interactive objects are buttons that start an 
application. Buttons can be pictures, text strings or a hot zone. A picture button can be the application's icon or 
some other picture (formats: bmp, jpg or jpeg) that you would prefer to use, like one you have designed yourself. A 
text string button is a word or phrase describing the application. A hot zone button is an area of Theme that when 
clicked on, starts an application; the zone itself is invisible.

Adding Buttons
Adding Pictures and Picture from Files
Adding Text Blocks
Adding Shapes
Adding Forms
Display sequence
Internal commands



BLOB has been modified.

Question: I have downloaded Talisman 1.1 and I think it is great! But, I have a problem! When I change things in
a theme and then restart, I get an error-message that says: BLOB has been modified. Sometimes I get an error-
message that says: Bitmap is not valid. It happens when I try to change AfterStep, Enlightenment and BeOs 
themes! Please help me!

Answer: It is an error in the database in one of the graphic fields. You can either delete the button or picture that
has the error or replace the corrupted graphic in ObjectEditor. The main difficulty is finding this corrupted field. Most
likely it is one of the last changed buttons. Another and cardinal way is to replace all database files runic.* with new.
You can also download the Tablepack Program from: http://www.lighttek.com/files/tablepack.zip. This simple tool can
be used to edit Talisman's table, runic.db, without Talisman.exe running at the same time. 



Color and Transparency.
Every object has a colored background. Consider what happens when you open a graphics editor and create a new 
file. When the window for that new file is opened, there will be a base or background color. You then create your 
graphic on top of that background color. If the graphic completely fills the window, the background color effectively 
disappears. If, however, you use only a part of the window, what you do not use is taken up with the background 
color. When that graphic is brought into Talisman, the background color is brought along.
Talisman treats text blocks and application icons used as buttons    as having transparent backgrounds. For all other 
objects, Talisman treats their backgrounds as solid.
When "Color" appears in an object change pop-up menu, it means the background color. For all intents and 
purposes, when an object (remember, not a text block or an application icon used as a button) is brought into a 
Talisman Theme, Talisman ignores the individual colors in the object and simply treats it as a solid object. The 
change color command allows you to select a specific color, then have Talisman treat that color, where ever it 
appears in the object, as transparent, semitransparent or solid.
An example. Your Talisman Theme has a green background. You have used a TextString button to start Excel, and 
you have use a small right arrow to indicate that the button does something. The arrow is blue on a black 
background. On the green Theme background, what you see is a 20x20 object - black with a blue arrow. You want to
get rid of the black. To do that you would first select the black color using the pop-up menu and the Windows color 
picker, then select "Transparent." The black background will disappear and just the blue arrow will remain.
Text blocks are a little different. By default, text blocks are transparent. If you change the color without changing 
the transparency, the new color will appear as the background color only when you click on the text block. If you 
change the color and the transparency to either semitransparent or solid, the new color will become the visible 
background of the text block.



Introduction
Talisman is a desktop alternative for Windows 95/98/NT, capable of transforming your computer into a magical 
world arranged as you like. The program's basic purpose: Launch other applications in a new interface, instead of 
with the standard Windows desktop. But the opportunities presented by Talisman are much broader. The program 
does not limit your computer fantasies - draw anything you like and arrange it as your imagination tells you to. 
When you get tired of looking at the same screen - change it all over again. If you are in a good mood - throw 
flowers and favorite photos on the screen. If you're not feeling so bright – leave the black screen with lonely Norton 
Commander or a pie-wearing Bill Gates. Create invisible buttons - they will open those places and the pictures, 
known only to you. Construct galleries of the best pictures and photos. Simply create your own little world, created 
by and for you, instead of staring at the same lines of icons on your desktop, year after year.

What Is Possible With Talisman?

The basic sphere of application of Talisman is the creation of custom-made interfaces for computers running 
Microsoft Windows 9x or NT.
Now, with the help of Talisman, it is possible to create a rather interesting virtual world on the computer. This world 
can contain sets of screens, forms, "rooms" and objects. All these objects can respond to movements or clicks of the
mouse.

Basic Concepts.

The program creates its own window on top of the Windows9x/NT Desktop. All program objects are located in this 
window.
The objects can have any size within the limits of the basic Talisman window.
Each object can run external programs or internal shell commands.
The behavior of an object depends on its type. Each type has a certain set of properties.

Features 

· Creating multilevel user defined desktops 
· Use of any number of pictures of any type or dimension, instead of standard icons. 
· Place, free-moving and imposing of objects in the Talisman workspace. 
· All objects can run external programs or internal shell commands by one click of the mouse. 
· The number of forms (screens) in one theme can range from 1 to 999. Any screen object can be set to switch from 
one form to another. 
· You can create a set of independent themes, and store them on any disk in the local computer or on a local area 
network. 
· You can easily switch between different themes through your own objects or through the Talisman menu. 
· The Built-in Object Editor allows the creation, modification and removal of any element in a theme. 
· Large number of basic elements (forms, pictures, buttons of different types,text blocks) 
· Storage of all workspace configuration data is done in a database which is "Paradox" formatted to allow editing by 
standard means. 
· Skinable Syspad window with trayicons, tasklist and clock. 
· Sound support for all events. 
· Startmenu, Taskmenu and Foldermenu commands. 

Getting Acquainted With Talisman
Using Talisman as a Shell
Sounds in Talisman
Internal commands
Frequently Asked Questions
 





Themes

Creating your Themes

Example of Talisman theme:

      

You can work with the startup Theme, download other themes from the Talisman site 
http://www.lighttek.com/themes, or create your own. 
If you want to create your own, there are two ways to go about it. You could use the startup Theme, delete all the 
objects, then start over. The easier way is to go to the Edit Mode>Theme>New. When selected, a popup dialog asks
for the name of the new Theme, creates a folder for it in the Themes subdirectory, and creates a new Runic.db and 
related files in the folder. The Theme created consists of one screen size form.

Using a Downloaded Theme

Many Themes are available for downloading from the World Wide Web at such sites as http://www.lighttek.com/themes, 
http://skinz.org. Using a downloaded theme presents two major difficulties. First, the path statements for application
will have to be changed. Second, the Theme may have been developed for a screen size that is different from the 
one you are using. 
If it is like the Boldovsky Theme, above, there isn't really anything you can do except center the theme and use a 
Windows wallpaper to complement it. If it is composed of interlocking pieces (like javascript buttons on web pages) 
that together make up a picture, you might to be able to use it by adapting the third procedure, below.
If it uses a solid color background or a picture, single or tiled: 

800x600 partial screen with solid color background: you should be able to use it at a higher resolution by 
simply moving it to where ever you want it on the desktop (Edit Mode>Themes>Move/Resize). 

800x600 full screen with solid color background: you should be able to use it at a higher resolution, but you 
will have to: 

· change the background color to match your background; 
· move the theme to the upper left hand corner where you want it to start (i.e., top=0, left=0); 
· resize it downward to the right hand corner; and 
· reposition everything to where you want. 



800x600 full screen with single graphic background (a 800x600 bmp or jpg): you will have to: 
· move the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); 
· resize it downward to the right hand corner (in the Object Editor, get the size of form0; you'll need that for the 

next step); 
· consider what you are going to do with the graphic: 
· delete it: use the Object Editor to delete it (Edit Mode>Object>Editor>form0, then delete in the graphics 

window); 
· keep it as the background: when the theme is resized, the background will tile across the new size, if you like it 
tiled, leave it alone; otherwise use a screen capture application to capture it, then using your favorite graphics 
editor, crop it, resize it (probably won't work very well) or change the canvas size to the form0 size, do something 
with the new surrounding empty space, save it as a bitmap, then use the Object Editor to make it the background 
for form0; 
· keep it as a picture: when the theme is resized, the background will tile across the new size, if you like it tiled, 
leave it alone; otherwise use a screen capture application to capture it, then using your favorite graphics editor, 
crop it, save it as a bitmap, use the Object Editor to bring it back into the theme as a picture, and put it where you 
want it); or 
· change it: use the Object Editor to change it. 
· reposition everything to where you want. 

800x600 full screen with a tiled graphic background: you should be able to use it by 
· moving the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); and 
· resize it downward to the right hand corner (the background will retile to the new size).
Uploading a Theme
We are always on the lookout for new Talisman Themes. We encourage new and experienced Talisman users to 
make their themes available to the Talisman user community. The Talisman Theme repository is located at 
www.skinz.org in the Talisman Section.

In order to upload a theme to    www.skinz.org, you will need to establish an account (it’s free). Then follow the 
instructions for uploading. We recommend that you 

1) Pack your theme before uploading it (use the “Pack Theme” button in the Object Editor). This is in addition to zipping it.
2) Large background pictures should be handled as “picture from file,” rather than loaded from the database. For large background 
pictures use the 256 color bmp-files or JPEG-files. Be sure to include the picture in the zip file and that the database includes the 
correct path.
3) If the second and third pictures for graphic buttons are the same as picture one, delete the second and third pictures.
4) If your theme has the object "Picture from file", please, check the filename of this pictures in Object Editor. Filename should not 
have a local path string from your computer. For example: 
correct filename: picture.jpg
wrong filename: f:\programs\talisman\themes\mynewtheme\picture.jpg
5) Make fullscreen JPEG screenshot for skinz.org (not GIF as they wrote!)



Display Sequence.
Talisman uses a specific sequence to display objects on the Theme. Talisman displays objects in the order in which 
you created them. For example, if you create two objects of the same size each on top of the previous, Talisman will
only display the last object created. You can, however, change the display sequence through the pop-up menu. Use 
the sub-commands "Send to back" or "Bring to front." 



E-Mail Addresses for Registered Users

Question: I have registered Talisman, but have not gotten back my registration key.

Answer: Sometimes the e-mail address is incorrectly entered in the registration form and the e-mail with the key
is bounced back as undeliverable. If you haven't received your key in seven days, contact Lighttek from you primary
e-mail address



Editing a Parent Form's Properties - Basic

Primary Parent or Base Form.

Four things can be changed: the background color, the background image, the location and size. The background 
color is changed through the Object>Color command. The background image may only be changed in the Editor. 
The location and size are changed through the Theme>Resize/Move command. Autohide and semitransparent do 
not have any effect on the Base Form.

Secondary Parent.

Since a secondary parent is the same size as the primary, its size and location would not change, but its color or 
background image may. Use Object>Color to change the background color. The background image may only be 
changed in the Editor. The Object>Autohide and Theme>Resize/Move command do not have any effect

Editing a Child Form's Properties - Basic
Changing the Form's Size.

When a form is created using the pop-up menu in Edit Mode, Talisman creates a new form the same size as the 
primary parent. If you want to use the new form as a child on either the primary parent or on a secondary parent 
and do not want the form to be "full size," you will have to change the form's size. The form's size may only be 
changed in the Talisman Editor. In Edit Mode, select Object>Editor. This opens the Talisman Editor. Find the fields 
labeled "Width" and "Height." Change these numbers to the size you want. The numbers are in pixels.



Editor Control Buttons

OK: closes the Editor window and writes changes to the database;
Redraw: redraws the screen;
Restore: restores an object’s characteristics to what they were before changes were made and may be used only 
immediately after the changes, but before another object is selected;
Cancel: dismisses the Editor window without effecting any changes; and
Pack Theme: refreshes the database by permanently deleting any records marked for deletion.



Object Information Window.

The Object Information Window contains all the information about the selected object when it was created or after it
has been edited. The information about each object may be edited in this window. Across the top of the window is a 
title bar. It contains a description of the object (button, picture, etc.), its number or name and two buttons: “Ren” 
and “Del.” “Ren” is used to rename the object. “Del” is used to delete the object.

For theme properties. 

Show main menu elements:    Show/hide any elements of main menu;
Show windows taskbar: Show/hide Windows taskbar (only for not-shell mode of Talisman);;
Theme always on back:    Change default position of Talisman window;

Syspad always on top: Change default position of syspad window (only for shell mode of Talisman);
Tray orientation: Horizontal or Vertical orientation of syspad's tray    (only for shell mode of Talisman);
Syspad Top and Left: coordinates of syspad (only for shell mode of Talisman);
Show syspad elements: Show/hide any elements of syspad: move button, start button, task button, clock    (only 
for shell mode of Talisman).

For buttons and pictures there is a graphics window below the title bar with five to seven editing buttons along the 
right side. The window for a textblock does not contain any right side buttons. There is no window for a shape. The 
graphics editing buttons are:

Open: Opens the standard Windows “Open” dialog;
Copy: Copies the graphic in the window to the Windows clipboard;
Paste: Pastes the contents of the clipboard into the object’s window;
Delete: Deletes the graphic in the window;
Undo: Undoes the last change to the graphic in the window;
Color Picker (Eye Dropper): Used to select a color as the transparent color (See Color and Transparency); and
Select Color (a Down Arrow): Used to select a color from the standard Windows color picker.

For buttons, the graphics window shows a preview of the assigned graphic and three tabs below it: Normal, 
Highlight and Click. Clicking on one of those tabs shows the graphic assigned to the corresponding button state. The
graphics window editing buttons at the right side work for the specific button state selected.

For pictures, the graphics window shows the picture or a portion of the picture if it is too large to fit in the window.

For forms, the graphics window is by default black and empty. Note, however, that where the graphics window for 
buttons and picture shows a “Preview” of the button or picture, the graphics window for forms is labeled 
“Background Image.” Using the Open button and selecting a graphic will result in that graphic being tiled 
throughout the form (the same as tiled background images on the Window’s desktop or on Web pages).

Below the graphics or textblock window (remember, there is no shape window) is information about the object. The 
information varies based on the object selected.

For all objects – forms, buttons, pictures, shapes and textblocks:

Top:

Parent Forms: For a parent form (either primary or secondary; See Forms for an explanation of parent forms), top 
is measured from the top edge of the screen. A top coordinate of 0 (zero) would place the form at the top edge of 
the screen, while a coordinate of 15 would place it 15 pixels down from the top. Negative coordinates (e.g., -3) are 
also possible, but they indicate that a portion of the object is outside the visible desktop or Talisman window.



Child Forms and Objects: For a child form (See Forms for an explanation of child forms) and all objects, top is 
measured from the top of the parent form. A top coordinate of 0 (zero) would place the child form at the top edge of
the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of the parent. Negative 
coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside the visible desktop or
Talisman window.

Left:

Parent Forms: For a parent form (either primary or secondary), left is measured from the left edge of the screen. A 
left coordinate of 0 (zero) would place the form at the left edge of the screen, while a coordinate of 15 would place 
it 15 pixels in from the left. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the 
object is outside the visible desktop or Talisman window.

Child Forms and Objects: For a child form and all objects, left is measured from the left edge of the parent form. 
A left coordinate of 0 (zero) would place the child form at the left edge of the parent form, while a coordinate of 15 
would place it 15 pixels in from the left edge of the parent. Negative coordinates (e.g., -3) are also possible, but 
they indicate that a portion of the object is outside the visible desktop or Talisman window.

Height: 

The height of the object in pixels.

Width: 

The width of the object in pixels.

For Forms:

Background color: Used to set the color of the form. This is overridden when a background image has been 
selected for the form.
Autohide form: Causes the form to disappear automatically when the cursor moves off the form.
Semitransparent form: Normally a form is opaque. If semitransparent is selected, what is behind the form will 
partially show through. If, however, the form’s background color is black (RGB = 0,0,0) and semitransparent is 
selected, the form becomes transparent. This does not work with the Base Form.

For Buttons.

Use text as hint or label: When a button is created, the third dialog window assigns a name for the button. By 
default, Talisman uses the textstring as a label for the button and displays that label below the button. This option 
permits the use of the textstring as a hint, rather than a label, that appears when the cursor moves over the button.
Text: The textstring used for the hint or label.
Command: The Talisman built in command or path statement for the executable.
Path: The working directory for the application. By default, this path is unassigned.
Font: The font, size, style and color used in displaying the hint or label. When the button is a textstring, two colors 
appear. Color 1 is the UP color and Color 2 is the HIGHLIGHT color.

For Pictures.

Type: Talisman treats pictures as either a “picture from database” or “picture from file.” This shows the type of 
picture.
Filename: If the picture is a “picture from file,” this shows the path to the picture. It can also be used to change 
the picture by changing its path.
For Shapes.
Color: Shows the color of the shape object.
For Textblocks.
Background color: Shows the color of the background for the textblock. This background is used only when the 
textblock is edited. It has no effect when in Work Mode.
Font: The font, size, style and color used in displaying the textblock.





Forms
As Object Containers

As we have mentioned before, a Theme is a collection of forms and objects. A Theme must have one form. If a 
Theme has more than one form, each additional form serves as a container for additional objects: buttons, pictures,
text blocks.

What Are They Good For - When To Use

The purpose of Talisman is to provide a desktop that is attractive and functional. It is easy to make the main form 
attractive: add a couple pictures and tile the background image using a pleasing texture. Almost as soon as you 
start adding buttons, though, attractiveness begins to diminish.
Except for the main form, all other forms are hidden until they are invoked. Thus, using additional forms gives you 
the opportunity to populate your Theme with as many buttons, pictures and textblocks as you want, but keep them 
hidden until you need them. Forms are also a means of organizing your buttons. For example, you might have a 
form containing buttons for basic productivity applications, another form for graphics applications and a third form 
for games.

Creating a Form

In the Edit Mode, select New>Form. Talisman creates a new form. It assigns it the next number in the form 
sequence, colors it blue, and makes it the same size as the Base Form. It also adds a textstring button "This is 
formX. Press here to back in main form," where "X" stands for the form number. Talisman can contain up to 1000 
forms (parent form 0 through parent form 999). The parent form 0 (zero) is reserved for the primary parent form, 
the Base Form.

Invoking a Form

Just an application can be started using a button, a button is used to invoke a form. Before creating a button to 
invoke the form, you must first create the form, then create the button to invoke the form.
Creating the button, however, is complicated by how you want the button to invoke the form: by rollover or by click.
A form invoked by a rollover button will be a popup form and, if the form hides the button, the form can be edited in
the Editor to autohide when the cursor moves off the form.

Creating the Button

Create a button to invoke the form just like you would any other button. In the Edit Mode, select New>Button. In the
command box, select "go to form XXX," where "XXX" is the form number (form9 would be shown as "009"). 
Selecting “popup form XXX” will create a form that pops-up when the cursor moves over the button and, , if the 
form hides the button, the form can be edited in the Editor to autohide when the cursor moves off the form. Select 
the button type. If you select picture, you will have to have your own graphic for the picture (some sample button 
graphics are available at the Talisman site (http://www.lighttek.com/themes ). Rollover buttons may use all three 
button states, but usually only the normal or UP state is necessary (actually, this depends on whether the button is 
hidden by the form or not; if it is not hidden the HIGHLIGHT state can be used and will remain visible as long as the 
form itself in visible). Click buttons may use all three button states. 

Types of Forms

The next logical step would be to start populating the new form with objects. But it's not. There are a few things you
need to consider before you begin: where you want the form to appear, what type of form it should be and what its 
size and position will be.



Parent and Child Forms.

Technically, the main form, the one you see when a Theme starts, is the parent form, and all other forms are its 
children. As you will see in a moment, it might be simpler, however, to discuss forms as primary parent, secondary 
parent, and child. 
The primary parent form is form 0, the Base Form for the Theme and the one that appears when Talisman is started.
A secondary parent form is a form the same size as the primary, but underneath, hidden by, the primary. A child 
form is a form layered on top of either the primary parent form or a secondary parent form.
A base with a just a primary parent is like a sheet of paper. A base with a primary parent and one or more 
secondary parents is like a stack of papers, with the primary parent as the top sheet in the stack. A child form is like
a 3M Post-It Note stuck on one of the sheets of paper.

Editing the Form

Moving the Form



Frequently Asked Questions
E-Mail Addresses for Registered Users
Using Sound in a Theme
Using a Theme Developed at One Resolution at Higher Resolutions
Using the Talisman RunTime Version
BLOB has been modified
Using Talisman as a Shell



Getting Acquainted With Talisman.

Start Talisman. Once it has started, you should notice two things: Talisman    covers all or part of the screen and has 
placed its icon in the System Tray. A left or right click on the Talisman icon pops up a menu with five sets 
commands: 
1. Theme. This has two options: Home returns to the Default Theme. Open Theme is used to open another theme.
2. Show desktop and Hide desktop. Show maximizes the Talisman window. Hide minimizes it.
3. Help: This has four options. Content opens the Talisman Help file. Talisman Homepage is a link to the World Wide
Web Home for Talisman. Talisman Themes is a link to the World Wide Web page for themes displayed on the 
Talisman Web Site. About/Registration gives information about the program and how to register to use it.
4. Commands: This has nine options: Run opens the Windows Run Dialog box. Find Files open the Find Files dialog. 
The following open the corresponding Explorer windows: Desktop, Programs, Documents, Explorer, Control Panel, 
Recycle Bin and Display Properties.
5. Shutdown and Quit: Shutdown opens the Windows Shutdown menu. Quit closes Talisman.

Unlike other Windows programs, Talisman's program Window is borderless because Talisman is designed to 
"replace" part or all of the Windows desktop and provide a more attractive and functional platform for launching 
programs. Unless you actually initiate a "Move/Resize" function (see Pop-up Menu (Edit Mode) ) the Talisman 
Window cannot be moved or resized.

In Talisman terms, the Talisman window is called a Theme. A Theme is a collection of forms and objects. Since this is
about getting started and getting started quickly, our discussion here will be limited to exploring the default Theme,
adding objects to it, and making certain kinds of changes. An object can be a button, a picture, or a text block. 
Buttons are interactive objects that ultimately result in the starting applications. A decorative object does not start 
any action. Pictures and, notwithstanding its usefulness to the user, a text block are decorative.

As a Microsoft Windows user, you are accustomed to seeing icons used to represent an application or a file 
associated with an application. As you look at the Talisman Theme, note the icons. If you move the cursor over one 
of them, it may stay the same or change states, similar to the popular Java-script buttons used on Web pages. 
Clicking on an icon may start an application. If it doesn’t, don’t worry. The program is not broken and you have not 
stumbled across a bug. All that is wrong is that the path statement used by the icon button is pointing to the wrong 
place. You can fix that. We suggest, however, that you wait a few minutes, read this documentation, do the 
exercises we have described in the section Adding Objects and review the section Making Changes.

In addition to icon buttons, the Theme may also contain graphics or text that are used as buttons to start 
applications. But, the graphics may be just decorative. The easiest way to tell the difference is to note how the 
cursor changes from the standard pointer, the arrow (unless you have changed it), to a pointing finger (the same 
way the cursor changes when moving over a link on a Web page). If the cursor doesn’t change, the graphic is 
decorative.

Further, buttons can used to open new pages, or in Talisman terms “forms.” As you move your cursor around the 
Theme, what looks like a new page may pop-up and it may contain additional buttons or graphics. When you move 
the cursor off the button or off the form, the form will disappear. This is part of the Talisman “magic”: keeping all 
those frequently used applications readily at hand, but hiding them until needed – all while letting you have the 
desktop you, not some faceless interface designer, want.
If, however, you want to jump right in and change things so you can begin using Talisman, the section Making 
Changes will explain how to change the path statements and other elements.



Icon Extraction

While Talisman has built-in icon extraction, one sometimes wants to use icons other than the application's built in 
default icon. Icons come built into the *.exe, as part of *.dll files, or as *.ico. Most graphics editors do not open these
files and permit saving them in a format other than their original one. We recomend to use the IconTOY for working 
with icons.

IconToy From Lighttek Software, it extracts icons from *.exe, *.dll, *.cpl, *.icl, *.ocx, *.scr and *.ico files; it also 
displays *.bmp. It will save the selected icons as *.ico (16color, 256color, High Color, True Color) or *.bmp or copy 
icon in clipboard (then you can paste it in Button Wizard or Object Editor). It can also be used to assign desktop 
wallpaper, either centered or tiled. Once the file extension is defined, it extracts the icons from all files of that type 
on the selected harddrive or partition.

http://www.lighttek.com



Internal Commands
startmenu
taskmenu
foldermenu        <path> <parameters>
path equivalents:
                                            programs
                                            desktop
                                            documents
                                            favorites
                                            strt
                                            quicklaunch
parameters:
                                                                                            menutop
                                                                                            menubottom
                                                                                            menuright
                                                                                            menuleft
quit
about
minimize
shutdown
moved
closeform
showdesktop
open
home
desktop
programs
documents
run
findfile
Go to form XXX
Popup form XXX

htmlback object_name
htmlforward object_name
htmlhome object_name
htmlrefresh object_name
htmlstop object_name
htmlurl object_name <URL>

Other frequently used commands
Control Panel:
explorer.exe ::{20D04FE0-3AEA-1069-A2D8-08002B30309D} \::{21EC2020-3AEA-1069-A2DD-08002B30309D} 
Dialup Networking :
explorer.exe ::{20D04FE0-3AEA-1069-A2D8-08002B30309D} \::{992CFFA0-F557-101A-88EC-00DD010CCC48}
Inbox:
explorer.exe ::{00020D75-0000-0000-C000-000000000046} 
My Computer:
explorer.exe ::{20D04FE0-3AEA-1069-A2D8-08002B30309D} 
Network Neighborhood:
explorer.exe ::{208D2C60-3AEA-1069-A2D7-08002B30309D} 
Printers. Use Control Panel command: 
control main.cpl printers 
Recycle Bin:
explorer.exe ::{645FF040-5081-101B-9F08-00AA002F954E}



Control Panel commands:
Accessibility Options: control access.cpl
Add New Hardware: control sysdm.cpl add new hardware
Add/Remove Programs: control appwiz.cpl
Date/Time Properties: control timedate.cpl
Display Properties: control desk.cpl
FindFast: control findfast.cpl
Internet Properties: control inetcpl.cpl
Joystick Properties: control joy.cpl
Keyboard Properties: control main.cpl keyboard
Microsoft Exchange (or Windows Messaging): control mlcfg32.cpl
Microsoft Mail Post Office: control wgpocpl.cpl
Modem Properties: control modem.cpl
Mouse Properties: control main.cpl
Multimedia Properties: control mmsys.cpl
Network Properties: control netcpl.cpl
Password Properties: control password.cpl
Power Management (Windows 95): control main.cpl power
Power Management (Windows 98): control powercfg.cpl
Printers Properties: control main.cpl printers
Regional Settings: control intl.cpl
Sound Properties: control mmsys.cpl sounds
System Properties: control sysdm.cpl



Locations and Moving Buttons.
Buttons are initially placed on the screen at the location where you right clicked to start the Button Wizard. Buttons 
can be moved once they have been finished. Here's how. In the Edit Mode, left click on the button, but keep your 
right mouse button pressed. This will bring up a dashed line around the button and the cursor will change. Hold the 
left mouse button down for about one second, then while still holding it down, drag the bounding box (the button 
stays in place, but the dashed box moves) to the location where you want it. Release the left mouse button. The 
button should appear in the new location. More precise positioning can be accomplished in the Talisman Editor.



Making Changes
As in creating buttons and adding pictures and text blocks, almost all of the editing of those objects can be 
performed using the right mouse click pop-up menu in the Edit Mode. The menu selection "Properties..." can be 
ignored. When the cursor is placed over an object to be edited, the pop-up menu becomes context sensitive; that is,
it displays those items that can be changed for that particular object 

Buttons.
Picture Buttons.

Transparent Color: See Color and Transparency.
Font: Used to change font used for the text string; opens the standard Windows font dialog box. Font size and color
are also changed here. If the color is changed, it only affects the UP color. Changes to the HIGHLIGHT color must be 
made in the Object Editor.
Command: Used to change the application to start; opens the standard Windows Open dialog box.

Text String Buttons.

Font: Used to change font used for the text string; opens the standard Windows font dialog box. Font size and color
are also changed here. If the color is changed, it only affects the UP color. Changes to the HIGHLIGHT color must be 
made in the Object Editor.
Command: Used to change the application to start; opens the standard Windows Open dialog box.
Hot Zone Buttons.

It is a Picture Button without pictures.

Pictures.
Transparent Color: See Color and Transparency.
Filename: Used to change the picture; opens the standard Windows Open dialog box.

Text Blocks.
Font: Changes the font used in the text block; opens the standard Windows font dialog box. Font size and color are 
also changed here.

Forms.
The Talisman Main Picture or form is basically the background that all the objects sit on. You can change this 
background in two ways: assigning a picture or changing its color.
Changing the color: If you do not want to use a tiled picture background, you can change the color from black. 
Selecting "Color" opens the standard Windows color picker. Choose a color, click "OK" and the background changes.
Autohiding the form: If you do not want the form to autohide (that is, disappear when you move the cursor off 
the form), deselect "Autohide."



Moving the Form
Once you have changed the form's size to something smaller than "full size," you can move it to where you want it. 
In the Edit Mode, select New>Button. In the command page of the Button Wizard, select "Moved" from the drop 
down menu and select textstring as the button type (you can select any of the three button types, but this button is
temporary, so why put a lot of effort into it). On the text page, key in some letters and click finish. Once out of the 
Editor, click and hold on the Move Button you just created. When the dotted line bounding box appears, you can 
reposition the form where you want it. After you finish moving the form, delete the Move Button (Object>Delete).

Moving a "Full Size" Form

A "full size" form can be moved just like a smaller form. Talisman will only display that part of the form still 
remaining within the boundary of the Base Form’s defined size. This means that at least two edges of the "full size" 
form will be the same as the Theme's edges.

Placement of a Child Form

Moving the form establishes its position relative to the top left corner of the Theme. Placement of the form, on the 
other hand, deals with its location relative to its invoking button. The invoking button can either be visible along 
with the form or hidden by the form. It’s your choice, but remember that if you want to the form to autohide, the 
form must cover the invoking button.

Autohiding a Child Form

A Child Form may be autohidden or not. Use Object>Autohide to control this attribute. Autohide only works when 
the form hides the invoking button.



New Command.
Contains sub-commands: 

Button: Creates a new interactive object using a Button Wizard.
Picture: Creates a new decorative object using the Windows Open dialog box. This object is stored within Talisman.
Picture from File: Creates a new decorative object using the Windows Open dialog box. The difference between 
this object and the Picture object is that this object is just a pointer to the disk location of the picture.
Shape: Creates a rectangle with any solid color without any command (like a picture button). It eliminates the need
to create rectangular color blocks in an outside graphics editor and add them as pictures.
Text block: Creates a new object for a block of text.
Form: Creates a new form with one "back button."
Theme: This command is used to start a new Theme. When selected, a popup dialog asks for the name of the new 
theme, creates a folder for it in the Themes subdirectory, and creates a new Runic.db and related files in the folder. 
The Theme created consists of one screen size form.



Object Editor

Using The Object    Editor.

This part of the guide provides additional information for the advanced user. Its focus is on the Object Editor and 
how it can be used to refine a Theme. The Editor cannot be used to add objects to a Theme. Objects can only be 
added using the Edit Mode right click popup menu “New.”
The Editor is the heart and soul of getting Talisman to "do its thing." The Editor is the GUI to the database records 
and fields. The following is a description of the Editor's elements of the Editor. The Editor window consists of three 
parts: on the left, a tree diagram showing the structure of the Theme; in the center, all the information about the 
currently selected object and editing controls; and on the right, Editor Control Buttons.

Tree Diagram
Editor Control Buttons
Object Information Window
Internal Commands



Organization of Talisman
Talisman's Basic Parts

The program consists of 3 parts:
The file talisman.exe (and also the library syspad.dll) is the main component.
The main database component is runic.db (and the files runic.mb, runic.px). These were created using Borland's 
Paradox. All objects and their properties are stored in it. The starting base should be placed in the working 
catalogue of the program. All additional bases can be placed anywhere. They and their related files must, however, 
be named "runic."
The Borland Database Engine, BDE 4.0, is the binding element between the database and the program. While 
BDE 4.0, in its runtime form, contains many functions that are not needed for Talisman the program cannot work 
without it.

Visible Interface of the Program: Forms and Objects.

Forms are the foundations on which objects reside. A Theme may consist of one form with many objects or several 
forms each with its own collection of objects. Each form has its own number. The main form is numbered 0 (zero) 
and is the main window of the program. It is the form seen when the program starts. Each subsequent form will be 
numbered consecutively after that starting with 2, then 3, then 4, and so on. All subsequent forms are child 
windows of the main form. 
An object can be a button, a picture or a text block. Objects can be either interactive or decorative. An interactive 
object is one that ultimately results in the starting of an application. A decorative object does not start any action. 
Notwithstanding its usefulness to the user, a text block is decorative. The objects inside each form, like the forms 
themselves, are by default numbered. For example, the main form, Form 0, may have 10 objects inside it. Each of 
the 10 objects will have a number, beginning with 2 (the form itself is object 1) and ending with 11. Objects can be 
added to or subtracted from a form.

Organization Of Database Component, runic.db

The database Runic.db contains 25 records.

1. Form - number of form
2. Number - number of object in current form
3. Top - y-coordinate of object in pixels from top of current form, except for form 0 (zero), then it is the coordinate 
from the top edge of the screen.
4. Left - x-coordinate of object in pixels from left of current form, except for form 0 (zero), then it is the coordinate 
from the left edge of the screen.
5. Width - width of object in pixels
6. Height - height of object in pixels
7. Path - full path of associated file or name of internal shell's command
8. Hint - caption or hint or textstring for text buttons
9. Priznak - type of object (button, picture etc)
10. Color - color of object
11. Pic1 - Image 1
12. Pic2 - Image 2
13. Pic3 - Image 3
14. Pic4 - Image 4
15. Font - fontname
16. Size - font size
17. FontType - font style (normal , bold, italic)
18. FontColor - font color
19. X - X displacement of text field in pixels
20. Y - Y displacement of text field in pixels
21. W - not used
22. H - not used
23. Dir - current work directory



24. Name - name of object
25. Memo - field for any text data <64kb



Pixel Measurements
Question: Sometimes it would be useful to know about where on the screen an object should go or is. Is there 
an easy way to do that?

Answer: MicroFox Software has created a virtual ruler app called Screen Ruler. It comes in two versions: the 
freeware version only measures pixels; the shareware version has other units of measurement. The text file 
accompanying the app says:
Screen Ruler is a great virtual ruler ready to be dragged around on your computer screen. This Windows 95/NT 32bit
application is very useful to measure objects in Pixels. It features a vertical or horizontal orientation, a dynamic 
mouse measurement tracking, custom length, plus it can also remain on top, above all windows. Try it! Named 
"Cool Tool" by Internet World magazine. Very handy when designing Web Pages and other screen layouts. The 
registered version is even better.

http://www.kagi.com/microfox/



Registration
See also: Registration in Europe

Talisman is distributed as Shareware. You may use the shareware version for 30 days. If after 30 days you would like
to continue using it, then You should purchase a license. After you pay, you receive Registration Name and 
Registration key to tell Talisman that you have paid the shareware fee.

The fee for registered version of Talisman is: 

Single user license      $25.00.

Talisman CDROM*....$45.00

Site license**.............$500.00 

*Talisman (one user license) and about 100 themes for it. Abracadabra 1.26 (shareware-version), Melody 1.52 
(shareware-version), IconTOY 3.1 (shareware-version), CD-version of Lighttek's website.
**Site licenses cover a single organization for an area of up to one hundred miles (160 km) in radius.

----------------------------------------------------------------------------------------------------------------------
Talisman RT is a run-time version of Talisman without all functions of editing.
You can use Talisman RT (with themes created in Talisman) on PCs 
where you want to protect your interface from editing. 
Prices:

10 users                  $100.00
20 users                  $150.00
50 users                  $300.00
100 users              $500.00
-----------------------------------------------------------------------------------------------------------------------

We accept the following types of payment: Credit card, Fax, Phone, Mail, Cash. All payment must be in US currency. 
On payment approval we'll send you the registration key which will remove all limitations of unregistered version. 
Your registration will be valid for all future versions 1.x.
If you do not get your registration key within a reasonable amount of time (two business days for credit card 
payments or two weeks for other payments), please notify us about that! We're very sorry for any inconvenience 
caused by those delays.

1. Through the World Wide Web. 

This is the fastest and easiest way. Your credit card information is sent directly to the credit card processor in a very 
secure manner, so that nobody else can see it. That protects you by ensuring that nobody but you and the credit 
card processor will see your card.
You can go directly to the order page: 

Talisman    (full version): https://www.regnow.com/softsell/nph-softsell.cgi?item=1333-4      

or:      http://shareit1.element5.com/programs.html?productid=104136&language=English



Talisman RT:    https://www.regnow.com/softsell/nph-softsell.cgi?item=1333-5

2. Telephone and Fax Orders 

These types of orders should include ALL information contained on the Order Form. 
Telephone 
Toll Free: 877-353-7297
Regular: 425-392-2294 
Fax 
Toll Free: 888-353-7276
Regular: 425-392-0223 

You should include an additional $2.50 per order for Fax Orders or $3 for Telephone orders. 

3. Paying by Check via Postal Mail 

You should make checks payable to Universal Commerce, Inc., including the product's ID (for Talisman 1333-4) on 
the "memo" of the check. All order information except credit card information should be included in the Order Form 
mail to: 

Universal Commerce, Inc.
ATTN Orders
PO Box 1816 Issaquah, WA 98027
USA

You should include an additional $2.50 per order for Mail orders. 
Registration Benenefits

Object Editor is available after registration.
No nags.
Lifetime technical support including support via e-mail.
FREE upgrade to new versions during the life of version 1.x. 
Product notification by e-mail. 
Beta testing for newest version! 

 



Vertrieb in Deutschland (Europe):

One user- Lizenz Preis: 45DM (23Euro)

Uberweisung: 
Andreas Bruckmann
Konto: 2706661
BLZ: 37070024
Bank: Deutsche Bank 24
Deutschland

Scheck an:
Andreas Bruckmann
Perleberger Weg 33
40593 Duesseldorf

Information: +49-171-6004033
E-Mail: proauto@gmx.de



Ðåãèñòðàöèÿ ïî÷òîâûì èëè áàíêîâñêèì ïåðåâîäîì ïî Ðîññèè

Âàðèàíò ðåãèñòðàöèè, äåéñòâóþùèé òîëüêî äëÿ æèòåëåé Ðîññèè è ñòðàí áûâøåãî Ñîþçà - ïî÷òîâûé, òåëåãðàôíûé 
ëèáî áàíêîâñêèé ïåðåâîä äåíåã â ðóáëÿõ. Ñòîèìîñòü ðåãèñòðàöèè -200 ðóáëåé. ×òîáû âîñïîëüçîâàòüñÿ ýòèì ñïîñîáîì 
ðåãèñòðàöèè, ïîøëèòå çàïðîñ íà àäðåñ support@lighttek.com . Âàì áóäóò âûñëàíû àäðåñ äëÿ ïåðåâîäà è èíñòðóêöèè.



Sounds in Talisman
Starting with Version 1.1. there are six events for which a sound can be played. Any wav file can be used, but for a 
specific event the wav must have a specific name. Also, to play, the wav files must be in the Theme directory for 
the particular theme for which you want sound. The sound possibilities are: 
· sound when a new Theme is loaded: use a wav named "start.wav" 
· sound when mouse moves over button: use a wav named "over.wav" 
· sound when a button is clicked: us a wav named "click.wav" 
· sound when showing a new form (Command: Go to form xxx): use a wav named "form.wav" 
· sound for a popup form (Command: Popup form xxx): use a wav named "popup.wav" and 
sound for a popup menu: use a wav named "menu.wav"



The Talisman window, menu commands

The Talisman window

When Talisman starts up, what you see is the Talisman Window. Unlike other Windows programs, Talisman's program
Window is borderless because Talisman is designed to "replace" part or all of the Windows desktop and provide a 
more attractive and functional platform for launching programs. Unless you actually initiate a "Move/Resize" 
function (see Pop-up Menu (Edit Mode) ) the Talisman Window cannot be moved or resized.

The Talisman Modes

Talisman has two modes: a Work Mode and an Edit Mode. When Talisman starts up, you are in Work Mode. This is 
where you use Talisman as your launchpad - opening spreadsheets, graphics editors or whatever application you 
may use. In the Edit Mode, you change the contents of the Theme itself.

Popup menu (work mode)

Once a Talisman Theme is open, right clicking with the mouse will pop-up a menu. The menu contains six sets of 
commands. Five correspond to the same ones as the right click menu in the Talisman Systray icon with the new one
for switching to the Edit Mode:

Switch to Edit Mode: 
Switches to the Talisman Edit Mode for adding or changing forms and objects. Clicking on a button in the Edit Mode 
will not start an application. You must switch back to the Work Mode.
Task list:
Show task list.
Applications:
Show Start menu
Theme submenu
    This has options: 
    Home returns to the Default Theme. 
    Open Theme is used to open another theme. 
    Open theme folder is used to open explorer window with filelist of current theme. 
    Set as default: This command tells Talisman to ignore the Theme in its directory and use the open Theme as the
startup one. This can be useful when the user has multiple Themes available and wants to      alternate among them 
as the startup. Once a Theme has been defined as the default, selecting the Home command, when working on a 
non-default Theme, reinstates this Theme. 
    This submenu show all additional themes in Talisman/Themes subfolder also.

Run:
Windows Run dialogue.
FindFiles:
Windows Find File dialogue (don't work in shell mode of Talisman).
Show and Hide: 
Show maximizes the window. Hide minimizes the Talisman window.
Help: 
Contents opens the Talisman Help file. Talisman Homepage is a link to the World Wide Web Home for Talisman. 
Talisman Themes is a link to the World Wide Web page for themes displayed on the Talisman Web Site. 
About/Registration gives information about the program and how to register to use it.
Commands: 
This has nine options: Run opens the Windows Run Dialog box. Find Files open the Find Files dialog. The following 
open the corresponding Explorer windows: Desktop, Programs, Documents, Explorer, Control Panel, Recycle Bin and 
Display Properties.
Shutdown and Quit: 
Shutdown opens the Windows Shutdown menu. Quit closes Talisman.
Any element of work-mode menu may be disabled/enabled in Object Editor's theme tab.



Popup menu (edit mode)
When the Edit Mode is selected, the right click pop-up menu displays the following commands. 

Work Mode: Switches out of the Talisman Edit Mode.
Object: Contains various sub-commands depending on the object clicked on.
New: Contains sub-commands: Button, Picture, Picture from File, Text block, Shape, Form, HTML page and Theme.
Delete: Deletes the object clicked on. 
Copy and Paste: Used to copy and paste objects; becomes active once an object has been selected. Objects can 
be copied and pasted on the same form and from one form to another. When objects are copied and pasted, they 
retain the same characteristics as the original object. If the copied and pasted objects are interactive (a button, for 
example), the Filename it starts will need to be changed.
Send to back.
Bring to Front.
Properties Open the Object Editor.



Theme Command.
Contains sub-commands: 

Set as default: This command tells Talisman to ignore the Theme in its directory and use the open Theme as the 
startup one. This can be useful when the user has multiple Themes available and wants to alternate among them as
the startup. Once a Theme has been defined as the default, selecting the Home command, when working on a non-
default Theme, reinstates this Theme



Tree Diagram
At the left side of the Object Editor window is a tree diagram showing the structure of the current Talisman Theme. 
Folder icons indicate forms. Below each folder, form, will be a listing of all the objects on the form. Each object has 
an icon and either a number or a name. The icon indicates the kind of object:
Theme icon: indicates a common theme's settings;
Button icon: indicates a button object;
Pyramid-like icon: indicates a picture or picture from file object;
Text page icon: indicates a text block object;
Layer rectangle icon: indicates a shape object; and
Red right arrow: indicates the object currently selected for editing.
HTML page icon: indicates a HTML object;
By default, Talisman assigns a number to each form’s object. Unless the creator of the Theme has given the object a
name, the assigned number will appear in the tree diagram.



Using Sound in a Theme
Question: Can I use sound in a Theme?

Answer: Yes, starting with Version 1.1. That version defined six events for which a sound can be played. Any wav
file can be used, but for a specific event the wav must have a specific name. Also, to play, the wav files must be in 
the Theme directory for the particular theme for which you want sound. The sound possibilities are: 
· sound when a new Theme is loaded: use a wav named "start.wav" 
· sound when mouse moves over button: use a wav named "over.wav" 
· sound when a button is clicked: us a wav named "click.wav" 
· sound when showing a new form (Command: Go to form xxx): use a wav named "form.wav" 
· sound for a popup form (Command: Popup form xxx): use a wav named "popup.wav" and 
sound for a popup menu: use a wav named "menu.wav"



Using Talisman as a Shell
What is a shell?
Very simply, a shell is two things: the operating system's graphical user interface, and the operating system's 
homebase.

As a GUI, a shell draws the desktop. In other words, what one sees after Windows has finished loading is the product of the shell. 
The icons and their arrangement, wallpaper display, the taskbar and systray are all brought about by the shell.
The other part of what a shell is is harder to explain. Basically, without a shell, the OS has no where to work. When 
the shell fails, the OS "crashes" and nothing happens. One could say that the shell is the OS's controller - kind of 
like an air traffic controller for aircraft. 
With Version 1.2, Talisman can function as a competent replacement for explorer.exe. While versions prior to 1.2 are
usable as shell replacements, they did not include the taskbar, systray or automatic starting of applications in the 
windows>start menu>programs>startup folder or those in the registry scheduled to run at startup. 
How do I setup my system to use Talisman as a shell?
Windows 9x uses the system.ini file to control various system settings, one of which is the shell. Under the [boot] 
section of the system.ini file, there is a statement: shell=explorer.exe. In order to use Talisman as the shell, that 
statement needs to be changed to: shell=c:\talisman. Here's a step by step:

Location of the Talisman Directory.
The default installation directory is c:\talisman. For a shell to startup up properly, the path in the system.ini file 
must be in the DOS 8.3 format. If you have installed Talisman in a different directory, you can use Windows File 
Manager to see the DOS 8.3 names (File Manager only uses the 8.3 format, Explorer does not). To open File 
Manager use Start>Run>winfile.

Changing System.ini in Windows95.
This procedure uses c:\talisman as the directory; if your directory is different, change it, but be sure to use the DOS 
8.3 names.

· Open a text editor such as Notepad
· Open c:\windows\system.ini (if your windows directory has a different name, substitute that name)
· Find the section that starts with [boot]
· Locate the line shell=explorer.exe
· Put a semicolon (;) in front of this line
· Move the cursor to the end of this line and hit the Enter key
· Key in the following new line: shell=c:\talisman\talisman.exe
· Save the changes and exit the text editor
· Make sure the following files are in the same directory as your theme:    t_normal.bmp, t_pressed.bmp, 
t_tray.bmp and t_clock.bmp
· Restart Windows.
· To return to explorer.exe as your shell, follow steps 1 - 3, then remove the semicolon at the beginning of the 
line shell=explorer.exe and put a semicolon at the beginning the line shell=c:\talisman\talisman.exe. Then save the 
changes, exit the text editor, and restart Windows.
· You can create a Talisman button to automatically open system.ini in notepad. In the Edit Mode, select 
New>Button and in the command line, put notepad.exe c:\windows\system.ini, choose the button type and 
complete it as you normally would. 
Changing System.ini in Windows98.
This procedure uses c:\talisman as the directory; if your directory is different, change it, but be sure to use the DOS 
8.3 names. There are two ways to change shells: you can either use the Win95 steps above or use msconfig as follows:

· Choose Start>Run and key in msconfig
· Hit OK



· Click on the system.ini tab
· Click on the plus sign to the left of the [boot] folder to expand it
· Click new and in the textblock key in shell=c:\talisman\talisman.exe
· Hit enter
· Click the Move Down button to move it down so it is with the shell=explorer.exe line
· Uncheck the shell=explorer.exe
· Click OK and Yes when prompted to save the changes.
· Make sure the following files are in the same directory as your theme: t_caption.bmp, t_normal.bmp, 
t_pressed.bmp, t_tray.bmp and t_clock.bmp
· Restart Windows.
· To return to explorer.exe as your shell, follow steps 1 - 3, check the line shell=explorer.exe and uncheck the line
shell=c:\talisman\talisman.exe, click OK and Yes when prompted to save the changes, then restart Windows.
What to do if the system will not startup with Talisman as the shell
If your system will not startup with Talisman as the shell, it is easy to go back to explorer.exe as the shell, but 
requires a step backward into the pre-Windows95 days of DOS. Here's what to do:

· Restart your computer - either turn it off, then back on or hit the reset button.
· With this step timing is critical. As your computer reboots, it will run through a series of checks (memory, hard 
drives, etc.). After the checks, it will normally display a screen showing your basic hardware configuration. When it 
does that, push the F8 key (Windows95 and Windows98 do things a little differently here: Win95 shows a statement 
Starting Windows95, but Win98 does not). Shortly after pushing the F8 key, you will be presented with a menu of 
startup options.
· Select Start at command prompt
· When you get a c:> prompt, key in edit c:\windows\system.ini (if your windows directory is named something 
else use that).
· The screen will change and you will be presented with a basic text editor. Most likely, you won't be able to use 
your mouse, so you will have to navigate with the keyboard. Use the down arrow to get to the proper line (shell=), 
then make the necessary changes.
· Exit the editor. The keystrokes are alt+f to open the File Menu; then x to exit; then y to save the changes.
· Restart.
Setting up the Syspad - Tasklist, Systray and Clock.
The Syspad is made up of four separate elements, starting from the left: the Caption, the Tasklist, Systray and 
Clock. The Caption is used to move the Syspad to a different location on the screen. The Tasklist is a dropdown 
menu of open applications. It functions the same as the Windows Task Manager or Alt+tab. The Systray holds icons 
for applications usually run at startup and providing system functions; for example, anti-virus and sounds. The Clock
provides a 24 hour clock.

Syspad Location
The Syspad can be positioned anywhere on the screen. It can only be positioned horizontally. To change its position 
left click on the Caption (the part of the Syspad at the far left with the dots on it) and while keeping the left mouse 
button down, drag the Syspad to its new location. Talisman remembers the new location and will put the Syspad 
there the next time the computer is started.

Syspad Graphics
The Syspad graphics can be changed to match your theme. There are five graphic elements used in constructing 
the Syspad. Buttons has two states: 1 - normal; 2 - pressed.

t_move1.bmp, t_move2.bmp: used to move the Syspad to a new screen location. 
t_clock1.bmp, t_clock2.bmp,: used as the background for the clock.
t_task1.bmp, t_task2.bmp: tasklist button.
t_start1.bmp, t_start2.bmp: start button.
t_tray1.bmp, t_tray2.bmp: used to construct the Systray; Talisman uses as many of these are there are Systray 
icons.
Activating New Syspad Graphics
Changes in the Syspad graphics do not become active until after theme has been reloaded.



Using a Theme Developed at One Resolution at Higher 
Resolutions

Question: I have a 1024x768 screen or 1200x... How I can use an 800x600 theme in fullscreen mode?

Answer: The answer depends how the background is constructed. If it is like the Boldovsky Theme 1, there 
isn't really anything you can do except center the theme and use a Windows wallpaper to complement it. If it is 
composed of interlocking pieces (like javascript buttons on web pages) that together make up a picture, you might 
to be able to use it by adapting #3, below. 
If it uses a solid color background or a picture, single or tiled: 

1. 800x600 partial screen with solid color background: you should be able to use it at a higher resolution by 
simply moving it to where ever you want it on the desktop (Edit Mode>Themes>Move/Resize). 

2    800x600 full screen with solid color background: you should be able to use it at a higher resolution, but 
you will have to: 
· change the background color to match your background; 
· move the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); 
· resize it downward to the right hand corner; and 
· reposition everything to where you want. 

3. 800x600 full screen with single graphic background (a 800x600 bmp or jpg): you will have to: 
· move the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); 
· resize it downward to the right hand corner (in the Object Editor, get the size of form0; you'll need that for the 
next step); 
· consider what you are going to do with the graphic: 
· delete it: use the Object Editor to delete it (Edit Mode>Object>Editor>form0, then delete in the graphics window);
· keep it as the background: when the theme is resized, the background will tile across the new size, if you like it 
tiled, leave it alone; otherwise use a screen capture application to capture it, then using your favorite graphics 
editor, crop it, resize it (probably won't work very well) or change the canvas size to the form0 size, do something 
with the new surrounding empty space, save it as a bitmap, then use the Object Editor to make it the background 
for form0; 
· keep it as a picture: when the theme is resized, the background will tile across the new size, if you like it tiled, 
leave it alone; otherwise use a screen capture application to capture it, then using your favorite graphics editor, 
crop it, save it as a bitmap, use the Object Editor to bring it back into the theme as a picture, and put it where you 
want it); or 
· change it: use the Object Editor to change it. 
· reposition everything to where you want. 

4. 800x600 full screen with a tiled graphic background: you should be able to use it by 
· moving the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); and 
· resize it downward to the right hand corner (the background will retile to the new size).



Using the Talisman RunTime Version
Question: I am the systems administrator for a small training company. I saw your program available on the 
internet and I purchased it to check it out to see if it's something that could be integrated into our systems. We run 
about 30 training workstations on Windows 98. We don't want people to have access to the recycle bin, task 
manager, control panel, explorer or quit. Basically making Talisman as the desktop for our entire computer. I was 
wondering if these features can be removed from the program. I also do graphic design and my boss wants me to 
make a custom desktop for her training environment. That is the reason I looked into Talisman in the first place. 
Although I haven't looked at the runtime version but I assume that's what we will have to get in order to implement 
this effectively. So if you could tell me if these things are possible please let me know. I was looking at the web site 
and I didn't see a runtime version available for english and a manual for Talisman ver. 1.1. I was just wondering if 
these were available or going to be soon.

Answer: You are correct. The RunTime version is what you need. Remember, though, you must have the full 
version to use the RunTime. TalismanRT has only all desktop features of Talisman without popup menu and 
everything it contains, such as the ObjectEditor or Button Wizard. Also your users will not have access to the 
Recycle Bin, Task Manager, Control Panel, or Explorer, as long as you do not make special buttons for them.



Introduction
Talisman is a desktop alternative for Windows 95/98/NT, capable of transforming your computer into a magical 
world arranged as you like. The program's basic purpose: Launch other applications in a new interface, instead of 
with the standard Windows desktop. But the opportunities presented by Talisman are much broader. The program 
does not limit your computer fantasies - draw anything you like and arrange it as your imagination tells you to. 
When you get tired of looking at the same screen - change it all over again. If you are in a good mood - throw 
flowers and favorite photos on the screen. If you're not feeling so bright – leave the black screen with lonely Norton 
Commander or a pie-wearing Bill Gates. Create invisible buttons - they will open those places and the pictures, 
known only to you. Construct galleries of the best pictures and photos. Simply create your own little world, created 
by and for you, instead of staring at the same lines of icons on your desktop, year after year.

What Is Possible With Talisman?

The basic sphere of application of Talisman is the creation of custom-made interfaces for computers running 
Microsoft Windows 9x or NT.
Now, with the help of Talisman, it is possible to create a rather interesting virtual world on the computer. This world 
can contain sets of screens, forms, "rooms" and objects. All these objects can respond to movements or clicks of the
mouse.

Basic Concepts.

The program creates its own window on top of the Windows9x/NT Desktop. All program objects are located in this 
window.
The objects can have any size within the limits of the basic Talisman window.
Each object can run external programs or internal shell commands.
The behavior of an object depends on its type. Each type has a certain set of properties.

Features 

· Creating multilevel user defined desktops 
· Use of any number of pictures of any type or dimension, instead of standard icons. 
· Place, free-moving and imposing of objects in the Talisman workspace. 
· All objects can run external programs or internal shell commands by one click of the mouse. 
· The number of forms (screens) in one theme can range from 1 to 999. Any screen object can be set to switch from 
one form to another. 
· You can create a set of independent themes, and store them on any disk in the local computer or on a local area 
network. 
· You can easily switch between different themes through your own objects or through the Talisman menu. 
· The Built-in Object Editor allows the creation, modification and removal of any element in a theme. 
· Large number of basic elements (forms, pictures, buttons of different types,text blocks) 
· Storage of all workspace configuration data is done in a database which is "Paradox" formatted to allow editing by 
standard means. 
· Syspad with trayicons, tasklist and clock. 
· Sound support for all events. 
· Startmenu, Taskmenu and Foldermenus commands. 

Getting Acquainted With Talisman
Using Talisman as a Shell
Sounds in Talisman
Internal commands
Frequently Asked Questions
 






